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VIl. External Modules Manual

About this Book

This book contains the manual for installation and configuration of external modules
for the RM4200D Digital Mixing and Routing System.

Tip: This book does not contain the instructions for the configuration software
Q Tool box4. You find them in Part 3 of this manual, ,,Toolbox4 Configuration
— and Reference.

While permanently developing the RM4200D Digital Mixing and Routing System,
DHD has published several modules, which need to be treated separately regarding
their special functionality. All the modules described in this manual were developed to
increase the range of features of the RM4200D. The modules are mostly stand-alone
devices connected directly or networked to one or more RM4200D systems. To make
their functionality available in an existing RM4200D installation, additional software
applications are needed. This manual shows, how to install external modules and to
configure them using corresponding applications.

The following modules are described in this book:

1. The RM420-015 TFT Display. This module can be used to enhance an RM4200D
Mixing console. With its 8,4 inch colored touch screen display, it gives a direct
feedback of the settings a mixing operator applies to a channel. Additionally, it
comes with 5 stereo level indicators, which can be connected to any available in-
ternal audio signal of the connected RM4200D.

Last update of this manual: September; 26th, 2006.
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1 RMA420-015 TFT Display

1.1 Overview

The RM420-015 TFT Display is an extension module for the RM4200D Digital Mixing
and Routing System.

It supports operators with a direct visual feedback of their changes on parameters - it
shows filter curves as well settings of dynamics. Additionally, the panel comes with 5
stereo level indications to display arbitrary signals from a RM4200D. Finally, 4
indicator fields can be assigned with logic sources from a RM4200D to show for
example ,,On Air“ or ,,Redlight” states.

The Panel is touch sensitive and enables the operator to set parameters or to select,
which parameters are displayed on the panel.

1.2 Installing the panel

The integration of an RM420-015 TFT Display into an existing RM4200D installation
is not complicated. Both systems exchange data via TCP/IB so both need to be
connected to a ethernet switch (100MBit/s). A standard network cable (3m) is
included.

The Display comes with an external power supply, which feeds the module with 48V
DC.

Note: The RM420-015 TFT Display can not be powered with 24V from the
RM4200D device. Please use the external power supply included in the
shipment to power the module.

To mount the Panel savely on a table, the housing is supplemented with a massive
metal stand. This stand needs to be fixed with adequate screws.

Caution: The RM420-015 TFT Display is an electronical device with no active
cooling, for example by fan. Operation heat is lead away from the device by
natural convection. Therefore the display must not be mounted into any kind
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of housing or frame, which blocks the air grille on the backside and disallows
cooling air to flow around the chassis.

1.3 Important information for operating the panel

Important Note: Only one RM420-015 TFT Display can be used together with
one DSP Frame. Do not use more than one panels in combination with one DSP
Frame. Use the Panel only in applications as described in this manual.

Data exchange between TFT Display and RM4200D is handled via a direct TCP/IP
connection. While sharing level data of up to 5 stereo signals, a very high traffic is
generated between both devices. As the bandwidth of the CAN bus is the bottleneck
of the system’s communication structure, the user has to take care to keep the total
data traffic in an RM4200D within the limits.

These limits cannot be numeralized, because traffic on an RM4200D is related to
different parameters , such like type of commands, type of protocol, duration and
amount of commands, buffer states and so on.

The TFT display can be easily operated together with an RM4200D, even if this
console is driven in a network, sharing a lot of networked logics (Global Logics,
Global Resources, Global Potentiometer, ...) with other consoles. If traffic reaches or
exceeds the internal bandwidth, the console may process delayed. If there are more
commands than the system can handle at a time, these data is buffered.

Note: Processing buffered data may cause delays. This behaviour is uncritical,
but could have an unsightly side effect: the levelmeters on the TFT screen may
be displayed stagnant.

The slow down of the displayed levels is a temporary effect, as long as the exceeding
of bandwidth is caused by traffic peaks. If an RM4200D is operated under contantly
high traffic conditions, the unsightly effect of stagnant meters reduces the effectivity
of the TFT display. That is the reason for the following specifications, when operating
an RM4200D in combination with an RM420-015 TFT display:

* Make sure, that your DHD devices are operated in a physically separated
network.

* Network devices have to be interconnected with 100MB/s switches, port speed
,2Auto Sense“.

* Do not use the RM420-553 Remote Control Software in combination
with an RM420-015 TFT display on the same console!

* Use the RM420-551 DSP Control Software only with reduced transfer
rate when combining it with an RM420-015 TFT display on the same console!
To start the software with a reduced transfer rate, create a shortcut to the
»access4.exe“ file, open the properties of this shortcut and enter ,,access4.exe - i
1000 into the target field.

Important Note: The data stream of level information from an RM4200D is
immediately stopped, whenever the connection between the TFT display and
the RM4200D is interrupted. It reestablishes automatically, when both are
connected again.
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1.4 Preparing the RM4200D Mixing Console

The RM420-015 TFT Display is able to display up to 5 stereo level indicators. The
signals which are indicated by the bargraphs need to be configured in the RM4200D
device. Inside the RM4200D, an already known function is used to realise the
indicator level information - the logic source Level Detection.

Important Note: The Firmware of the RM4200D must be upgraded to 5.05.09
or higher to enable the exchange of level data.
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To enable the level indicator bargraphs, up to 5 Level Detections can be config-
ured.

Figure 1-1:

The logic source Level Detection is still available as a known RM4200D feature in the
Tool box4. By clicking the Sel ect . . . button, the Audi o0 Sour ces window opens.
You can assign any of the available sources. Depending whether the selected source is
stereo or mono, the dedicated checkbox St er eo needs to be checked or not. The
potentiometer values Level , Correl ati on and Hol d Ti ne do not have any
influence on the PPM bargraphs.

It makes sense to assign important internal signals as sources for the level detection
(PGM out, PFL, Monitoring).

Important Note: Up to 5 Level Det ecti ons can be configured in one
RM4200D device. If a level detection is still used for another internal
functionality (i.e. ,,Silence detection“), you can parallely use the same Level
Det ect i on to feed a stereo indicator of the RM420-015, or you can configure
the Touchscreen panel, not to use this Level Detecti on.

Each Level Detection is feeding one stereo indicator. The large bargraph on the left-
hand side is connected to Level Detection 1. The following scheme is showing the
relation between Level Detections and the indicators.

VIl - 4 | Preparing the RM4200D Mixing Console
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Figure 1-2: RM4200D Level Detections and RM420-015 level indicators have a fixed rela-
tion.

Tip: If you would like to indicate the levels of more than 5 sources, choose an
output function containing a rotary monitor selector as source for a Level
Det ecti on.

1.5 TFTConfig - Configuring the panel

Using the software

The software to configure the Panel is called TFTConf i g. It is included within every
shipment.

TFTConf i g is a normal Windows program. It does not require any additional DLLs

or other files. For installation, copy the program file on to the hard drive of your PC.
To remove the program, just delete its program file. Start the software by opening the
file TFTConfi g. exe.

Important Note: The usage of the TFTConf i g software is only specified for
Windows XP and Windows2000 PC systems.

You can use the software without the RM420-015 hardware, e.g. to change or check
configurations “offline”. However, in most cases the configuration PC is connected to
the Display.

Note: Using Ethernet to connect the TFTConf i g software to the RM420-015
TFT Display requires the correct configuration of the IP addresses.

The File Menu

New
With this command you can generate a new, empty configuration file. Alternatively
you can create a new file by hitting the following icon:

r
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Open

Use this command to open an existing TFT configuration file. The dialogue for file
selection is displayed; only RM420-015 configuration files are shown. The files bear
the suffix

* TFT .

Alternatively you can open the file dialogue by hitting the following icon:

By

Save (Ctrl+S)

With this command you can save the currently open TFT configuration. If you have
started with a new file, you will be asked for a filename. A file dialogue opens in
which you can enter name and location for the new file. If a file already exists, the
existing file will be overwritten.

You can also call the command by hitting the following icon:

b

Save As...

With this command you can save the currently open TFT configuration as a file with
another name. A file dialogue opens in which you can enter name and location for the
new file. If a file with the same name already exists, you have to confirm the
overwriting.

After saving, the script editor progresses in the new file.

Exit

This command closes the configuration software. If the current file contains still
unsaved changes, an according dialogue will ask you to save them.

The View Menu

Test Colors

The function Test col or s switches on a test mode for the logic indicators. With
Test Col or s activated, the software displays the configured colors for the logic
indicators.
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Figure 1-3: Test colors displayes the configured colors for the logic indicators.

You can also call the command by hitting the following icon:

T

TFT Display setup...

TFT Di splay setup... opens a dialogue to specify the interconnection between
the TFT display and an RM4200D. In the first text field (TFT Di spl ay nodul e
nane), you can enter a name for the RM420-015 TFT Display. This name is basically
used to simplify your work.

Hit the Sel ect ... button to choose an RM4200D configuration file (*.ddp)
containing the device which should be connected to the TFT display. After selection,
all devices configured in your *.ddp file are listed in the TFT Di spl ay connects
t o devi ce menu. Choose the desired device from this list.

The interconnection of TFT display and RM4200D system is based on TCP/IP
Therefore, the display needs to know the current IP address of the RM4200D. Click
the Det ect current button to read the IP address of the desired device.

Finally, hit the OK button to confirm the settings, or press Cancel to discard them.
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TET Display basic setup E|
Settings
TFT Dizplay module name TFT Panel
Related Tookox 4 Project file | L:\work\DOKUNTFTATEST. ddp
TFT Dizplay connects to device | Studial b
Device IP Address 192.1658.10.740
I k. L\\;J ’ Cancel l
Figure 1-4: The TFT display setup window is used to set the interconnection between

RM4200D and RM420-015 TFT Display.

Note: To operate together, TFT display and RM4200D system need to be
networked via ethernet. The devices have to be connected to the same subnet
sharing one IP range. Please refer to Part 5 of this manual, Installation Guide, to
learn more about networking RM4200D devices.

Maintenance Window

As already known from the Tool box4, also the TFTConf i g software comes with a
maintenance application. It is called Maintenance Window, too, but provides several
different options and features.

These changes were necessary because of the completely new hardware and software
concept, the RM420-015 TFT Display is based on.

The maintenance window will be explained in a later abstract of this manual.

The Transfer Menu

Load to TFT display...

This command copies the current configuration from the TFTConf i g software into
the selected RM420-015 TFT Display. First choose the command Load to TFT

di spl ay. In the DHD connection dialog you can select the desired Device. After
confirming the selection, the new configuration is transferred. Due to the small
amount of data, the transfering process is quite fast. No process bar will be shown
during upload.

Caution: Loading a new configuration irrecoverably overwrites the older
configuration available in the TFT display. Therefore, if in doubt, save the
current configuration to file before modifying it using the command Load from
TFT display.

You can also execute the function Load to TFT di spl ay. .. by clicking on the
icon
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in the toolbar.

Load from TFT display...

This command loads the configuration from a RM420-015 TFT Display into the
TFTConf i g software. In the DHD connection dialog, you have to select the
corresponding panel, too.

not be undone as soon as the project file is saved. Thus, you should always

. Caution: Please remember that the modification caused by the download can
work with copies of the original configuration files.

You can also execute the function Load from TFT di spl ay. .. by clicking on the
icon

ve

in the toolbar.

The Help Menu

About...
Here, the creation date of the software and version of the TFTConf i g software is
displayed, e.g. “Version 1.0.2 Build 0”. For service enquiries please always quote this
version description completely.

The main window
In the main window of the TFTConf i g software, you can adjust the settings for the
level and logic indicators. If you move the mouse cursor over the display layout, all
configurable fields will be highlighted.

If you click a highlighted level indicator field, you can configure its label and check,
whether it should be enabled or not.
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Figure 1-5: Click a selected level indicator field to enter a label for it. Confirm the changes

with OK to assign the label.

There is no possibility to define an assignment of RM4200D Level Detection signals to
the level indicators. This assignment is automatically done. (See “Figure 1—

2: RM4200D Level Detections and RM420-015 level indicators have a fixed relation.”
on page 5.)

If one of the highlighted logic indicators is clicked, a setup window is opened to
define settings. You can set a label for the indicator and assign a color for it. The
assignable colors will be shown later, when the Test col or s mode is activated.

Lok Goass

| ETART | 2TOR
kot rfipas ek Forel |
Figure 1-6: Click a selected logic indicator field to enter a label for it. After setting the color

and assigning the related logic source, confirm your settings with OK.
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Clicking the Sel ect . . . button besides the Logi ¢ Sour ce field opens the Logi ¢
Sour ces window as known from the Tool box4.

Logic Sources in Studio [

MNore s
Global Resources
Ri420-010 #C11
Clean Feed
GFI
Logic Functions
01| LF OM
02 |LF LS DIt
03 |LF REDLIGHT
04 LFLSCUTL
D5 |LFLSCUTR
Q& | LF MICS OM
07 | LF ISDM in
02 |LF TEL in

Global Logic k

Syztem Functions
Logic Delay
Lewvel Detect

-

-

Carrelation Detect
Fader Start Fader
Fader Start Channel

e -

|[ Select [ Cancel ]I

This window shows all available logic sources of the connected RM4200D, which can
be assigned to the logic indicators. Select the source you would like to indicate and
press Sel ect . The source will be listed in the Logi ¢ Sour ce text field. Whenever
this logic source is activated during operation, the indicator will be lit in the
configured color.

|- BB -

hd

By clicking the clock symbol a window opens, which enables the user to configure
own shortcut labels for the displayed days in the date line beneath the clock. If
nothing is changed here, the default values are the english days in 3-digit code
(MON, TUE, WED,...).

The Status bar

The status bar below the main window displays the current PC time (hh:mm:ss). It
also indicates, if the loaded TFTConf i g file has been changed (,,Modified*) and
shows context information about the highlighted area in the main window.

1.6 The Maintenance Window - F7

The Maintenance Window of the TFTConf i g software has been renewed completely
and is only basically comparable to the known Maintenance Window of the

Tool box4. This changes became necessary because of a new hardware and software
concept, which is introduced with the TFT display.

The display is driven by a microcontroller, which runs an operating system separated
from the systems firmware. While communication from or to the display is handled
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by the operating system, the firmware manages any handling of audio or logic

commands.

This separation i.e. allows to do firmware upgrades or resets without influencing the

operating system.

= DHD st e P
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RME200 Maintenance

Fri by 10 16530034 20065
1y 0 day 5 40
Serial Mumber (5000

11,11, 2006 LSALES  TFT sl 19 168 10148 Canvehed

The Maintenance Window is devided into three parts.

Device list

The column on the left-hand side shows all available TFT Displays and RM5200D
devices inside the network, your PC is connected to. The value listed here is called
Hardware Name. Each device has a fixed Hardware Name, which can be manually
assigned. This name has to be unique. If no name is entered, a device is listed with its
MAC address. This MAC address is already known from the RM4200D systems.

Network Config

If you right-click a device in the device list, a context menu is shown.

Important Note: Make sure that you enter IP addresses in the correct format

(XXX. XXX. XXX. XXX).

VIl - 12 | The Maintenance Window - F7
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Network Config El

Device

Serial Mo 050000 Retrieve Current

Hardware Mame:

Metwork IP Address

(%) Automatic via DHZP

) Fixed

IP Address: Subnet Mask:

Gateway: Broadcast:

Time

Time Server: 192.165.10.5 Setup time zone and DST ...
TZ config string

Mail
Mail Server: 192.165.10.5

Send l ’ Close

Device

The Seri al No represents the last 3 bytes of the MAC address of a device. If a
device is still running in your network, but is not reachable due a different IP
configuration, you can enter its MAC address (printed on its back) in the Seri al No
field and press the Ret ri eve Current button. The IP configuration is downloaded
and can be changed.

Enter a Har dwar e Nan® in the corresponding field to be able to identify your
hardware later.

Network IP Address

Enter the network settings for your device here. If the device is configured
automatically vi a DHCP, all other fields are deactivated.

Select Fi xed to manually insert your settings. If in doubt about what to enter here,
please contact your network administration for the correct values.

Time

In order to synchronize the clock shown on the display, the device needs to listen to a
Ti me Server in your network. A Time Server is represented by an application

running on a networked PC. If you do not already have a Time Server installed, you
can find several software solutions in the internet.

Note: If no Time Server is available in your network, the clock is not shown in
the TFT display.

Hit the Set up ti me zone and DST. .. button to specify your time zone settings.
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Mail Server

In case of a support request, you are directly able to send system information to
DHDs’ support via the maintenance window. Therefore, a Mail Server IP address
needs must be configured.

If you have finished your settings, hit the Send button to transfer the settings to the
dedicated device (identified by the Serial Number)

Click the O ose button to close the window.

Firmware Reset
This command forces a reset of the devices’ firmware. During a reset, the device will
not disappear from the device list. The display will not be switched off. Instead, all
indicators freeze for a while and the display refreshes completely after a couple of
seconds.

Important Note: If you have changed the time zone configuration, you need to
restart the firmware.

System Reboot

With this command, you can reboot the complete system, including its operating
system. The system reboot is a deeper engagement into the systems operation state.
The display will be switched off while the operating system reboots. After about 20
seconds, the device should be back running.

Note: A reboot of the system is only necessary, if the module obviously behaves
strange.

System information

If you select one of the listed devices by clicking on its name, the main display right
besides the device list shows some basic details about the selected device. The most
important information for service enquiries is listed here:
e Qperating System (Version 1.1.1 -- date): Thisis an information
about the version of the operation system.

* Firmpvare (Version : 5.99.0.20 ): This line indicates, which firmware
version is used on the device.

Please have this information present for service requests.

Protocol window

In the lower part of the Maintenance Window, protocol messages sent by the
connected devices are shown.
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